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1. INTRODUCTION

The RCM5400W RabbitCore modules use the Wi-Fi/802.11b/g
functionality of the Rabbit® 5000 microprocessor to allow you to
create a low-cost, low-power, embedded wireless control and
communications solution for your embedded control system. The
Rabbit® 5000 microprocessor features include hardware DMA,
clock speeds of up to 100 MHz, I/O lines shared with up to six
serial ports and four levels of alternate pin functions that include
variable-phase PWM, auxiliary 1/0O, quadrature decoder, and input
capture. Coupled with the existing opcode instructions that help to
reduce code size and improve processing speed, this equates to a
core module that is fast, efficient, and the ideal solution for a wide
range of wireless embedded applications.

The Development Kit has the essentials that you need to design
your own wireless microprocessor-based system, and includes a
complete Dynamic C software development system. This Devel-
opment Kit also contains a Prototyping Board that will allow
you to evaluate the RCM5400W RabbitCore modules and to
prototype circuits that interface to the RCM5400W modules.
You will also be able to write and test software for these modules.

Throughout this manual, the term RCM5400W refers to both the RCM5400W and
RCM5450W RabbitCore models unless one model is referred to specifically.

In addition to onboard Wi-Fi/802.11b/g functionality, the RCM5400W has a Rabbit 5000
microprocessor operating at 73.73 MHz, static RAM, flash memories, three clocks (main
oscillator, Wi-Fi oscillator, and timekeeping), and the circuitry necessary for reset and
management of battery backup of the Rabbit 5000’s internal real-time clock and the static
RAM. One 50-pin header brings out the Rabbit 5000 I/O bus lines, parallel ports, and
serial ports.

The RCM5400W modules receive their +3.3 V power from the customer-supplied moth-
erboards on which they are mounted. The RCM5400W modules can interface with many
CMOS-compatible digital devices through the motherboard.
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1.1 RCM5400W/RCM5450W Features

e Small size: 1.84" x 2.85" x 0.55"
(47 mm x 72 mm X 14 mm)

e Microprocessor: Rabbit 5000 running at 73.73 MHz
e Up to 35 general-purpose I/O lines configurable with up to four alternate functions
e 3.3 V1/O lines with low-power modes down to 2 kHz

e Six CMOS-compatible serial ports — four ports are configurable as a clocked serial port
(SPI), and two ports are configurable as SDLC/HDLC serial ports.

e Alternate I/O bus can be configured for 8 data lines and 6 address lines (shared with
parallel I/O lines), I/O read/write

e Airoha single-chip 802.11b/g transceiver

e Real-time clock

e Watchdog supervisor

Currently there are two RCM5400W production models. Table 1 summarizes their main

features.

Table 1. RCM5400W Features

Feature RCM5400W RCM5450W
Microprocessor Rabbit® 5000 at 73.73 MHz
Flash Memory 512K 1MB
Data SRAM 512K 512K
Fast Program-Execution SRAM 512K 1MB
Serial Flash Memory (data) 1IMB 2MB

6 shared high-speed, CMOS-compatible ports:
6 are configurable as asynchronous serial ports;
Serial Ports 4 are configurable as clocked serial ports (SPI);
2 are configurable as SDLC/HDLC serial ports;
1 asynchronous serial port is used during programming

Wi-Fi 802.11b/g standard, ISM 2.4 GHz

NOTE: There is a special version of the RCM5400W RabbitCore module for Japan. It is
functionally identical to the standard RCM5400W module and uses the same compo-
nents, but has been assembled to meet the Japan regulatory requirements. Be sure to
order the correct version for the market where you plan to use the RCM5400W. The
two versions can be distinguished by the labels on the RF shield as shown below.

Ce ce & )
RABBIT RCM5400W Standard Release Label RABBIT RCM5400wW]  Japan Version Label
DIGI® INTERNATIONAL DIGI® INTERNATIONAL

901-0190 901-0191
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The RCM5400W series is programmed over a standard PC USB port through a program-
ming cable supplied with the Development Kit. The RCM5400W may also be pro-
grammed remotely using the Remote Program Update library with Dynamic C v. 10.54 or
later. See Application Note AN421, Remote Program Update, for more information.

NOTE: The RabbitLink cannot be used to program the RCM5400W.

Appendix A provides detailed specifications for the RCM5400W.
1.2 Advantages of the RCM5400W

Fast time to market using a fully engineered, “‘ready-to-run/ready-to-program’ micro-
processor core module.

Competitive pricing when compared with the alternative of purchasing and assembling
individual components.

Easy C-language program development and debugging

Rabbit Field Utility to download compiled Dynamic C .bin files, and cloning board
options for rapid production loading of programs.

Generous memory size allows large programs with tens of thousands of lines of code,
and substantial data storage.

Easily scalable for commercial deployment applications
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1.3 Development and Evaluation Tools
1.3.1 RCM5400W Development Kit

The RCM5400W Development Kit contains the hardware essentials you will need to use
the RCM5400W module. The items in the Development Kit and their use are as follows.

RCM5400W module with 2.4 GHz dipole antenna.
Prototyping Board.

Universal AC adapter, 12 V DC, 1 A (includes Canada/Japan/U.S., Australia/N.Z.,
U.K., and European style plugs). Development Kits sold in North America may contain
an AC adapter with only a North American style plug.

USB programming cable with 10-pin header.
10-pin header to DBO serial cable.

Dynamic C® CD-ROM, with complete product documentation on disk.
Getting Started instructions.

A bag of accessory parts for use on the Prototyping Board.

Rabbit 5000 Processor Easy Reference poster.

Registration card.

Programming

Cable /

i

[omer]

Universal
AC Adapter
with Plugs

‘afﬁ‘% 4
Accessory Parts for Antenna
Prototyping Board

Instructions Prototyping Board

Getting Started

Figure 1. RCM5400W Development Kit
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1.3.2 Software

The RCM5400W is programmed using version 10.50 or later of Dynamic C. A compatible
version is included on the Development Kit CD-ROM. This version of Dynamic C
includes the popular uC/OS-II real-time operating system, point-to-point protocol (PPP),
FAT file system, RabbitWeb, and the Rabbit Embedded Security Pack featuring the Secure
Sockets Layer (SSL) and a specific Advanced Encryption Standard (AES) library.

NOTE: The RCM5400W was originally released with Dynamic C version 10.40. We
have since determined that the BIOS startup sequence used in Dynamic C versions
10.40 and 10.46 leads to a timing violation on the fast SRAM, which stores the applica-
tion developed to run on the RCM5400W and RCM5450W. The timing violation
occurs when the Rabbit 5000 clock doubler is enabled before its early output enable
timing is enabled. Under certain conditions, this prevents the application from loading
correctly, and may cause it to crash completely. Therefore, the RCM5400W and
RCM5450W require Dynamic C v. 10.50 or later to work properly.

In addition to the Web-based technical support included at no extra charge, a one-year
telephone-based technical support subscription is also available for purchase. Visit our
Web site at www.rabbit.com for further information and complete documentation, or con-
tact your Rabbit sales representative or authorized distributor

1.3.3 Online Documentation

The online documentation is installed along with Dynamic C, and an icon for the docu-
mentation menu is placed on the workstation’s desktop. Double-click this icon to reach the
menu. If the icon is missing, use your browser to find and load default.htm in the docs
folder, found in the Dynamic C installation folder.

The latest versions of all documents are always available for free, unregistered download
from our Web sites as well.
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1.4 Certifications

The systems integrator and the end-user are ultimately responsible for the channel range
and power limits complying with the regulatory requirements of the country where the end
device will be used. Dynamic C function calls and sample programs illustrate how this is
achieved by selecting the country or region, which sets the channel range and power limits
automatically. See Section 6.2.4.1 for additional information and sample programs dem-
onstrating how to configure an end device to meet the regulatory channel range and power
limit requirements.

Only RCM5400W modules bearing the FCC certification are certified for use in Wi-Fi
enabled end devices, and any applications must have been compiled using Dynamic C

v. 10.50 or later. The certification is valid only for RCM5400W modules equipped with
the dipole antenna that is included with the modules, or a detachable antenna with a 60 cm
coaxial cable (Digi International part number 29000105). Changes or modifications to this
equipment not expressly approved by Digi International may void the user's authority to
operate this equipment.

In the event that these conditions cannot be met, then the FCC certification is no longer
considered valid and the FCC ID can not be used on the final product. In these circum-
stances, the systems integrator or end-user will be responsible for re-evaluating the end
device (including the transmitter) and obtaining a separate FCC certification.

NOTE: Any regulatory certification is voided if the RF shield on the RCM5400W
module is removed.

1.4.1 FCC Part 15 Class B

The RCM5400W RabbitCore module has been tested and found to comply with the limits
for Class B digital devices pursuant to Part 15 Subpart B, of the FCC Rules. These limits
are designed to provide reasonable protection against harmful interference in a residential
environment. This equipment generates, uses, and can radiate radio frequency energy, and
if not installed and used in accordance with the instruction manual, may cause harmful
interference to radio communications. However, there is no guarantee that interference
will not occur in a particular installation. If this equipment does cause harmful interfer-
ence to radio or television reception, which can be determined by turning the equipment
off and on, the user is encouraged to try and correct the interference by one or more of the
following measures:

e Reorient or relocate the receiving antenna.

¢ Increase the separation between the equipment and the receiver.

Connect the equipment into an outlet on a circuit different from that to which the
receiver is connected.

Consult the dealer or an experienced radio/TV technician for help.
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Labeling Requirements (FCC 15.19)

FCC ID: VCB-E59C4472

This device complies with Part 15 of FCC rules. Operation is
subject to the following two conditions:

(1) this device may not cause harmful interference, and

(2) this device must accept any interference received, including
interference that may cause undesired operation.

If the FCC identification number is not visible when the module is installed inside another
device, then the outside of the device into which the module is installed must also display
a label referring to the enclosed module or the device must be capable of displaying the
FCC identification number electronically. This exterior label can use wording such as the
following: “Contains Transmitter Module FCC ID: VCB-E59C4472” or “Contains FCC
ID: VCB-E59C4472.” Any similar wording that expresses the same meaning may be used.

The following caption must be included with documentation for any device incorporating
the RCM5400W RabbitCore module.

Caution — Exposure to Radio-Frequency Radiation.

To comply with FCC RF exposure compliance requirements, for mobile
configurations, a separation distance of at least 20 cm must be maintained
between the antenna of this device and all persons.

This device must not be co-located or operating in conjunction with any
other antenna or transmitter.

1.4.2 Industry Canada Labeling

] [pousty industie  7443A-E59C4472

This Class B digital apparatus complies with Canadian standard
ICES-003.

Cet appareil numérique de la classe B est conforme a la norme
NMB-003 du Canada.
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1.4.3 Europe

The marking shall include as a minimum:

e the name of the manufacturer or his trademark;
e the type designation;

e cquipment classification, (see below).

Receiver - .
Class Risk Assessment of Receiver Performance

1 Highly reliable SRD communication media, e.g., serving human life
inherent systems (may result in a physical risk to a person).

) Medium reliable SRD communication media, e.g., causing
inconvenience to persons that cannot be overcome by other means.

3 Standard reliable SRD communication media,e.g., inconvenience to
persons that can simply be overcome by other means.

NOTE: Manufacturers are recommended to declare the classification of their devices in
accordance with Table 2 and EN 300 440-2 [5] clause 4.2, as relevant. In particular,
where an SRD that may have inherent safety of human life implications, manufacturers
and users should pay particular attention to the potential for interference from other
systems operating in the same or adjacent bands.

Regulatory Marking

The equipment shall be marked, where applicable, in accordance with CEPT/ERC Recom-
mendation 70-03 or Directive 1999/5/EC, whichever is applicable. Where this is not appli-
cable, the equipment shall be marked in accordance with the National Regulatory
requirements.
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2. GETTING STARTED

This chapter describes the RCM5400W hardware in more detail, and
explains how to set up and use the accompanying Prototyping Board.

NOTE: This chapter (and this manual) assume that you have the RCM5400W Develop-
ment Kit. If you purchased an RCM5400W or RCM5450W module by itself, you will
have to adapt the information in this chapter and elsewhere to your test and develop-
ment setup.

2.1 Install Dynamic C

To develop and debug programs for the RCM5400W series of modules (and for all other
Rabbit Semiconductor hardware), you must install and use Dynamic C.

If you have not yet installed Dynamic C version 10.50 (or a later version), do so now by
inserting the Dynamic C CD from the Development Kit in your PC’s CD-ROM drive. If
autorun is enabled, the CD installation will begin automatically.

If autorun is disabled or the installation does not start, use the Windows Start | Run menu
or Windows Disk Explorer to launch setup . exe from the root folder of the CD-ROM.

The installation program will guide you through the installation process. Most steps of the
process are self-explanatory.

Dynamic C uses a COM (serial) port to communicate with the target development system.
The installation allows you to choose the COM port that will be used. The default selec-
tion is COM1. You may select any available port for Dynamic C’s use. If you are not cer-
tain which port is available, select COM1. This selection can be changed later within
Dynamic C.

NOTE: The installation utility does not check the selected COM port in any way. Speci-
fying a port in use by another device (mouse, modem, etc.) may lead to a message such
as "could not open serial port" when Dynamic C is started.

Once your installation is complete, you will have up to three new icons on your PC desk-
top. One icon is for Dynamic C, another opens the documentation menu, and the third is for
the Rabbit Field Utility, a tool used to download precompiled software to a target system.

If you have purchased any of the optional Dynamic C modules, install them after installing
Dynamic C. The modules may be installed in any order. You must install the modules in
the same directory where Dynamic C was installed.
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2.2 Hardware Connections

There are three steps to connecting the Prototyping Board for use with Dynamic C and the
sample programs:

1. Prepare the Prototyping Board for Development.
2. Attach the antenna to the RCM5400W module.
3. Attach the RCM5400W module to the Prototyping Board.

4. Connect the programming cable between the RCM5400W and the PC.
5. Connect the power supply to the Prototyping Board.

footwear.while assembling the RCM5400W module, installing it on another

CAUTION: Provide ESD protection such as smocks and grounding straps on your
A board, and while making or removing any connections.

Remember to use ESD protection regardless of whether you are working with the
RCM5400W module on the Prototyping Board or in your own OEM application.

2.2.1 Step 1 — Prepare the Prototyping Board for Development

Snap in four of the plastic standoffs supplied in the bag of accessory parts from the Devel-
opment Kit in the holes at the corners as shown in Figure 2.

NOTE: Be sure to use the hole that is pointed out towards the bottom left of the Prototyp-
ing Board since the hole below it is used for a standoff when mounting the RCM5400W
on the Prototyping Board.

Figure 2. Insert Standoffs
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2.2.2 Step 2 — Attach the Antenna to the RCM5400W Module

Attach the antenna to the antenna SMA connector on the RCM5400W as shown in
Figure 3.

Y¥0653-80A 'GI‘QCH

2LYyO6S3-VEYLL :DI

(T s

RABBIT RCM5400W|
DIGI® INTERNATIONAL
901:0190

Figure 3. Attach the Antenna to the RCM5400W Module

CAUTION: Do not remove the RF shield by the antenna since any attempt to
A remove the shield will damage the RF circuits underneath it.

Any regulatory certification is voided if the RF shield on the RCM5400W module

is removed.

OEM User’s Manual

11




2.2.3 Step 3 — Attach Module to Prototyping Board

Turn the RCM5400W module so that the mounting holes line up with the corresponding
holes on the Prototyping Board. Insert the metal standoffs as shown in Figure 4, secure
them from the bottom using the 4-40 x 3/16 screws and washers, then insert the module’s
header J1 on the bottom side into socket RCM1 on the Prototyping Board.

Insert stail

between
mounting holes and
Prototyping Board.

o)
o o
00000000000
00000000000
Mooooooooooooogﬂ

= Q0000000000000
(ool clelelol0l0l0]0
00000000000
00000000000,
lelele ololelelolololezmn
00000000000"
00000000000
OOOOOOOOOO%UE

Line up mounting
holes with holes
on Prototyping Board.

el

O [ O 111138863683853 Eanu

V-

Figure 4. Install the Module on the Prototyping Board

NOTE: Itis important that you line up the pins on header J1 of the module exactly with
socket RCM1 on the Prototyping Board. The header pins may become bent or damaged
if the pin alignment is offset, and the module will not work. Permanent electrical dam-
age to the module may also result if a misaligned module is powered up.

Press the module’s pins gently into the Prototyping Board socket—press down in the area
above the header pins. For additional integrity, you may secure the RCM5400W to the
standoffs from the top using the remaining three screws and washers.
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2.2.4 Step 4 — Connect Programming Cable

The programming cable connects the module to the PC running Dynamic C to download
programs and to monitor the module during debugging.

Connect the 10-pin connector of the programming cable labeled PROG to header J2 on
the RCM5400W as shown in Figure 5. Be sure to orient the marked (usually red) edge of
the cable towards pin 1 of the connector. (Do not use the DIAG connector, which is used
for a normal serial connection.)

Remove slot cover,
insert tab into slot
A
Assemble
W@ AC Adapter AC Adapter
@ Snap plug into place

3-pin
power connector

Programmmg\;

Cable 0
Colored |,

ﬁ[-—

To
PC USB port

El
RABBIT RC\15¢
DIGI® INTERNA' O

B2

OOOOOOOO
g R

Figure 5. Connect Programming Cable and Power Supply

NOTE: Never disconnect the programming cable by pulling on the ribbon cable.
Carefully pull on the connector to remove it from the header.

Connect the other end of the programming cable to an available USB port on your PC or
workstation.

Your PC should recognize the new USB hardware, and the LEDs in the shrink-wrapped
area of the USB programming cable will flash — if you get an error message, you will
have to install USB drivers. Drivers for Windows XP are available in the Dynamic C
Drivers\Rabbit USB Programming Cable\WinXP 2K folder — double-click
DPInst.exe to install the USB drivers. Drivers for other operating systems are available
online at www.ftdichip.com/Drivers/VCP.htm.
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2.2.5 Step 5 — Connect Power

Once all the other connections have been made, you can connect power to the Prototyping
Board.

If you have the universal AC adapter, prepare the AC adapter for the country where it will
be used by selecting the appropriate plug. Snap in the top of the plug assembly into the slot
at the top of the AC adapter as shown in Figure 5, then press down on the plug until it
clicks into place.

Connect the AC adapter to 3-pin header J1 on the Prototyping Board as shown in Figure 5
above. The connector may be attached either way as long as it is not offset to one side—
the center pin of J1 is always connected to the positive terminal, and either edge pin is
ground.

Plug in the AC adapter. The PWR LED on the Prototyping Board next to the power con-
nector at J1 should light up. The RCM5400W and the Prototyping Board are now ready to
be used.

NOTE: A RESET button is provided on the Prototyping Board next to the battery holder
to allow a hardware reset without disconnecting power.

To power down the Prototyping Board, unplug the power connector from J1. You should
disconnect power before making any circuit adjustments in the prototyping area, changing
any connections to the board, or removing the RCM5400W from the Prototyping Board.
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2.3 Run a Sample Program

If you already have Dynamic C installed, you are now ready to test your programming
connections by running a sample program. Start Dynamic C by double-clicking on the
Dynamic C icon on your desktop or in your Start menu. Select Store Program in Flash
on the “Compiler” tab in the Dynamic C Options > Project Options menu. Then click
on the “Communications” tab and verify that Use USB to Serial Converter is selected to
support the USB programming cable. Click OK.

You may have to select the COM port assigned to the USB programming cable on your
PC. In Dynamic C, select Options > Project Options, then select this COM port on the
“Communications” tab, then click OK. You may type the COM port number followed by
Enter on your computer keyboard if the COM port number is outside the range on the
dropdown menu.

Now find the WIFISCAN. C sample program in the Dynamic C Samples\WiF1i folder,
open it with the File menu, then compile and run the sample program by pressing F9.

The Dynamic C STDIO window will display Starting scan. ..., and will display a list
of access points/ad-hoc hosts as shown here.

,ﬂ;?; wifi - Dynamic C Dist. 10.40 - [Stdio]
starting scan...
WiF1 Scan Results: 4 entries
Channel signal MAC Access Point SSID
5 35 00:18:ha:72:db:ad
= 20 00:14:a%:c8:47 20
7 18 00:0%9:5b:Ff8:8%:4h  rabhit
4 14 O0:lo:2f:ifaiez2:i20 rabwpaZ

The following fields are shown in the Dynamic C STDIO window.
e Channel—the channel the access point is on (1-11).

e Signal—the signal strength of the access point.

¢ MAC—the hardware (MAC) address of access point.

e Access Point SSID—the SSID the access point is using.
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2.3.1 Troubleshooting

If you receive the message Could Not Open Serial Port, check that the COM port
assigned to the USB programming cable was identified and set up in Dynamic C as
described in the preceding section.

If you receive the message No Rabbit Processor Detected, the programming
cable may be connected to the wrong COM port, a connection may be faulty, or the target
system may not be powered up. First, check to see that the power LED on the Prototyping
Board is lit. If the LED is lit, check both ends of the programming cable to ensure that it is
firmly plugged into the PC and the programming header on the RCM5400W with the
marked (colored) edge of the programming cable towards pin 1 of the programming
header. Ensure that the module is firmly and correctly installed in its connectors on the
Prototyping Board.

If Dynamic C appears to compile the BIOS successfully, but you then receive a communi-
cation error message when you compile and load a sample program, it is possible that your
PC cannot handle the higher program-loading baud rate. Try changing the maximum
download rate to a slower baud rate as follows.

e Locate the Serial Options dialog on the “Communications” tab in the Dynamic C
Options > Project Options menu. Select a slower Max download baud rate. Click OK
to save.

If a program compiles and loads, but then loses target communication before you can
begin debugging, it is possible that your PC cannot handle the default debugging baud
rate. Try lowering the debugging baud rate as follows.

e [ocate the Serial Options dialog on the “Communications” tab in the Dynamic C
Options > Project Options menu. Choose a lower debug baud rate. Click OK to save.

Press <Ctrl-Y> to force Dynamic C to recompile the BIOS. You should receive a Bios
compiled successfully message once this step is completed successfully.
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2.4 Where Do | Go From Here?

If the sample program ran fine, you are now ready to go on to the sample programs in
Chapter 3 and to develop your own applications. The sample programs can be easily mod-
ified for your own use. The user's manual also provides complete hardware reference
information and software function calls for the RCM5400W series of modules and the
Prototyping Board.

For advanced development topics, refer to the Dynamic C User’s Manual, also in the
online documentation set.

2.4.1 Technical Support

NOTE: If you purchased your RCM5400W or RCM5450W through a distributor or
through a Rabbit partner, contact the distributor or partner first for technical support.

If there are any problems at this point:
e Use the Dynamic C Help menu to get further assistance with Dynamic C.

e Check the Rabbit Technical Bulletin Board and forums at www.rabbit.com/support/bb/
and at www.rabbit.com/forums/.

e Use the Technical Support e-mail form at www.rabbit.com/support/.
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3. RUNNING SAMPLE PROGRAMS

To develop and debug programs for the RCM5400W (and for all
other Rabbit hardware), you must install and use Dynamic C.
This chapter provides a tour of its major features with respect to
the RCM5400W modules.

3.1 Introduction

To help familiarize you with the RCM5400W modules, Dynamic C includes several sam-
ple programs. Loading, executing and studying these programs will give you a solid
hands-on overview of the RCM5400W’s capabilities, as well as a quick start with
Dynamic C as an application development tool.

This chapter provides sample programs that illustrate the digital I/O and serial capabilities
of the RCM5400W RabbitCore module. Section 6.2.4 discusses the sample programs that
illustrate the Wi-Fi features.

NOTE: The sample programs assume that you have at least an elementary grasp of the C
language. If you do not, see the introductory pages of the Dynamic C User’s Manual
for a suggested reading list.

In order to run the sample programs discussed in this chapter and elsewhere in this manual,

1. Your module must be plugged in to the Prototyping Board as described in Chapter 2,
“Getting Started.”

2. Dynamic C must be installed and running on your PC.

3. The programming cable must connect the programming header on the module to your
PC.

4. Power must be applied to the module through the Prototyping Board.

Refer to Chapter 2, “Getting Started,” if you need further information on these steps.

To run a sample program, open it with the File menu, then compile and run it by pressing
F9.

Each sample program has comments that describe the purpose and function of the pro-
gram. Follow the instructions at the beginning of the sample program.

Complete information on Dynamic C is provided in the Dynamic C User’s Manual.
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